Faculty of Nursing - Research Portfolio Application Procedure Reference Guide

This handbook is meant as a brief overview of Research Portfolio and Research Services Office (RSO) general procedures. It is not a complete guideline; each sponsor and competition has its own guidelines that must be reviewed and followed. For more information, you may wish to visit the following links:

- [RSO website](http://www.rso.ualberta.ca)
- [Nursing Research Office website](https://uofa.ualberta.ca/nursing/research)
- [U of A Policies and Procedures Online (UAPPOL)](https://policiesonline.ualberta.ca)

Eligibility to Apply for and Hold Research Funding

The University of Alberta acknowledges the importance of research funding and that its responsibilities for research administration are followed. Research funding at the University is classified in the financial system as a Project. The Project Holder is the individual who is deemed accountable for the appropriate expenditure of the revenue placed in a Project, in compliance with the terms and conditions of the sponsor(s), and with University policies and procedures.

To see who is eligible to apply for all external and internal research funding and hold research projects at the University of Alberta, visit the [RSO website](http://www.rso.ualberta.ca) or click [HERE](https://uofa.ualberta.ca/nursing/research) to view the policy.

Notification of Intent to Apply

As soon as eligibility is determined, researchers must notify the Faculty of Nursing Research Office Office (NRO) of their intent to apply for research funding by sending an email to nursing.research@ualberta.ca.

Purpose

The purpose of the Notification of Intent to Apply (NOIA) procedure is to:

- Provide the URL to the sponsor’s guidelines in preparation for grant submission process
- Express intent to submit an application for preliminary comprehensive review
- Assist the NRO in the tracking of applications, facilitation of signatures, and submission of applications to the sponsor by the specified deadline

---

1 http://www.rso.ualberta.ca
2 https://uofa.ualberta.ca/nursing/research
3 https://policiesonline.ualberta.ca/Pages/default.aspx
4 http://www.rso.ualberta.ca/Applying/ApplicationsProposals/Submitting.aspx
5 https://policiesonline.ualberta.ca/PoliciesProcedures/Policies/Eligibility-to-Apply-for-and-Hold-Research-Funding-Policy.pdf

rev August 26, 2020
Procedure

All applicants are to notify the NRO of their intent to submit research applications and studentships (including LOI’s, registrations, and full applications) to both internal and external sponsors. This includes applications wherein the applicant is participating as a principal applicant or co-applicant.

Applicants are required to:

- Email a NOIA to nursing.research@ualberta.ca
- Email subject line = “Notification of Intent to Apply” and your name
- Include the sponsor’s deadline and the URL to the program guidelines on the sponsor’s website
- Applicants are required to advise the RPO of the following:
  - Request for preliminary comprehensive review (PCR)
  - Other considerations (see below)
- Review and understand the sponsor’s applications guidelines, particularly eligibility and evaluation criteria

Upon receipt of the NOIA, the faculty will receive a reply via email outlining important dates, deadlines, and information that the applicant should be aware of.

Other Considerations:

- **Is a Dean’s Letter of Support required for this grant application?** YES or NO. If yes, provide the Associate Dean Research with a draft version of the support letter at least **15 business days prior to the signature deadline** specified by the Faculty of Nursing or Institution.
- **Is an Institutional Letter of Support required?** YES or NO. As situations vary, the RPO will work together with the applicant to meet the sponsor’s requirements.

Signature Requirements

In addition to the signature requirements of the sponsor, the University of Alberta Signature policy dictates that all applications and proposals submitted for external funding must be circulated in **complete form** for review and approval prior to submission.

**IMPORTANT:** The Principal Investigator is responsible for obtaining all signatures required by the sponsor and by the U of A.

Researcher Home Page

The Research Services Office launched **Grants 3.0** on August 18, 2014, which included an upgrade to the Researcher Home Page, a self-serve online tool for researchers. Grants 3.0 is the name of the software

---

upgrade to the University's PeopleSoft grants management system used to track research grants and contracts and to manage all research funding received by the University of Alberta.

When applying for external funding (and some internal funding – see NRO for more information), Principal Investigators are responsible for completing the “Create Application/Proposal/Project” for in Researcher Home Page⁷. For more information, you may wish to visit the following link: Using the Researcher Home Page⁸.

**Budgetary Considerations**

Budgets and budget justifications in applications and proposals are often considered by reviewers as a good indicator of the feasibility of the research. A well-prepared budget may bring in more funding if the application is successful.

**Key Features of Exemplary Budgets**

- Expenses are well justified;
- Include brief discussion of trainees and employees (i.e. strengths, what they are expected to accomplish, names);
- Calculations are easy to follow;
- Overlap with other grants is clearly detailed, or lack thereof;
- Include contingency for the unexpected (experiments need to be run more than once);
- Only eligible expenses are requested;
- Expenses are linked to specific research objectives, milestones, or aims;
- Justification follows headings in the budget itself;
- Justification continues to convince the reviewer of the excellence of the research environment; and
- Budget is reasonable based on what is needed and what the sponsor is willing to pay.

Researchers must now apply for 30% indirect costs relative to the total cost of the research agreement with the exception of Tri-Council grants and those where expressly prohibited by a sponsor in writing (contact funding agency for confirmation).

If librarian services are required, researchers should include this in their budget (email jwslinfo@ualberta.ca to request core or specialized services).

If the use of the Health Research Data Repository (HRDR)⁹ is required, researchers should include this in their budget (contact the Nursing Helpdesk at nursing.helpdesk@ualberta.ca for details).

**Indirect Costs**

Indirect costs, also called overhead, are those expenditures incurred in the conduct of research that are not directly attributed to a specific research effort. Research is expensive. Maintenance of and improvements to

---

⁷ https://www.prodps.ualberta.ca/psp/fnprd/?cmd=login
⁸ http://www.rso.ualberta.ca/RISP.aspx
⁹ https://uofa.ualberta.ca/nursing/research/research-supports-and-services/hrdr
research infrastructure require ongoing reinvestment on a significant scale. For this reason, research project funding should cover the full costs of the research allowable under University policy.

Prior to any commitment of University resources to a research project, the Vice-President (Research) requires indirect cost recoveries in all research contracts, research grants, technical services agreements, flow through contracts and clinical trials, except where expressly prohibited by the granting organization.

**How Indirect Costs are Calculated**

The overhead amount is calculated based on the direct cost of research.

- It can be calculated on the total award amount using the percentage amount stated for the sponsored project. For example, for a total award of $50,000 with 30 per cent indirect costs, the calculation is as follows:
  - \( \frac{50,000 \times 0.30}{1.30} = 11,538.46 \). In this case the direct costs would be $38,461.54 a project with direct costs of $25,000 and 30 per cent indirect costs, the calculation is as follows:
  - \( 25,000 \times 0.30 = 7,500.00 \). In this case, the total award would be $32,500.

Certain sponsors will only allow indirect costs to be assessed on specific expenditures in the project; i.e., salaries, travel, etc.

The minimum indirect cost recovery rate for Research Grants, Contracts & Technical Service agreements is 30% of direct costs. This rate mirrors the rate provided from time to time by the Tri-Council, under the Federal Indirect Costs of Research program, and is therefore subject to change accordingly. Refer to the [Application for Indirect Costs Recovery Procedure](https://policiesonline.ualberta.ca/PoliciesProcedures/Procedures/Application-for-Indirect-Cost-Recovery-Rates-Procedure.pdf) for current rates and exceptions.

For more information on budgets and indirect costs, visit the [RSO website](http://www.rso.ualberta.ca/Applying/ApplicationsProposals/Submitting.aspx), or view the [Indirect Costs of Research Policy](https://policiesonline.ualberta.ca/PoliciesProcedures/Procedures/Indirect-Costs-of-Research-Procedure.pdf).

**Applying**

*Responsibilities of the Faculty of Nursing Research Portfolio Office,*

The Nursing Research Office Faculty of Nursing, (NRO) aids the researcher by facilitating the process of obtaining signatures from the Faculty of Nursing (Associate Dean Research) and University of Alberta (RF/RSO). **Applications must be submitted to the NRO a minimum of seven business days before the sponsor’s grant submission deadline,** in order that it reaches RSO five business days before the sponsor deadline, in accordance with U of A policy.

**Exceptions:** A number of programs, for example Canada Research Chairs and Canada Foundation for Innovation, may have RSO deadlines that are greater than five business days before the sponsor deadline.

---

10 [https://policiesonline.ualberta.ca/PoliciesProcedures/Procedures/Application-for-Indirect-Cost-Recovery-Rates-Procedure.pdf](https://policiesonline.ualberta.ca/PoliciesProcedures/Procedures/Application-for-Indirect-Cost-Recovery-Rates-Procedure.pdf)
11 [http://www.rso.ualberta.ca/Applying/ApplicationsProposals/Submitting.aspx](http://www.rso.ualberta.ca/Applying/ApplicationsProposals/Submitting.aspx)
These exceptions will be communicated to researchers via the RSO website\(^{13}\), Research Facilitation Offices, and/or the Associate Dean (Research) in the Faculty. In addition to these exceptions some units set their own internal review deadlines in advance of the five-business days required by RSO.

**IMPORTANT:** The Nursing Research Office does not obtain signatures on behalf of the PI. The Principal Investigator is responsible for obtaining all signatures required by the sponsor and by the U of A.

**Responsibilities of the University of Alberta Research Facilitation Office**

The Research Facilitator (RF) will review the application for adherence to the sponsor’s guidelines and the University policies and procedures. The RF’s review notes will be provided to the Principal Investigator in writing and should be considered. If there are any major deficiencies (budget corrections, missing signatures), or if the PI or Co-Investigator is found to be ineligible to apply, the RF will withhold signoff until these issues are addressed.

\(^{13}\) [http://www.rso.ualberta.ca/Applying/ApplicationsProposals/Submitting.aspx](http://www.rso.ualberta.ca/Applying/ApplicationsProposals/Submitting.aspx)
Application Checklist

1. NOTIFICATION OF INTENT TO APPLY
   □ Forward a notification of intent to apply to the Coordinator (nursing.research@ualberta.ca)

2. SIGNATURES
   □ Obtain all required signatures (including):
     □ Agency required signatures
     □ U of A required signatures
   □ Complete and sign a copy of the funding agency’s signature page(s)
   □ Complete the "Create Application/Proposal/Project" form in Researcher Home Page

3. BUDGET
   Please remember the following points when completing your budget:
   □ Researchers must apply for 30% indirect costs relative to the total cost of the research agreement
     with the exception of Tri-Council grants and those others that do not allow this line item (contact
     funding agency for confirmation).
   □ If specialized librarian services are required, researchers should include this in their budget
     (contact jwsinfo@ualberta.ca for details).
   □ If the use of the Health Research Data Repository (HRDR) is required, researchers should include this
     in their budget (contact the Nursing Helpdesk at nursing.helpdesk@ualberta.ca for details).

4. FINAL SUBMISSION
   □ Submit the final, signed electronic version (PDF) of the application to the Faculty of Nursing Nursing
     Research Office via email at nursing.research@ualberta.ca, a minimum of seven business days
     before the sponsor deadline for faculty of nursing signatures. THE RPO will then submit your
     application to RSO. Applications must be submitted as one complete document; separate files will
     not be accepted (see Pg. 11 for instructions on combining PDF documents in Adobe Acrobat). RSO
     will send you a pdf of the University of Alberta Signatures. The PI is responsible for the final
     submission to the granting agency.
   □ IF SPONSOR REQUIRES HARD COPY: Submit the final, signed hard copy of the full application to the
     Coordinator a minimum of seven business days before the sponsor deadline to ensure that the
     application is reviewed and returned to you by RSO in a timely manner.

14 https://www.prodps.ualberta.ca/psp/finprd/?cmd=login
Accessing Adobe Acrobat DC via Citrix

This is a brief guide to the new method of accessing Adobe Acrobat DC using Citrix. It consists of two portions:

1. A one-time setup process
2. Launching the application after setup is complete.

Note that the setup and use process will be fairly different if you’re accessing Citrix from a computer outside the Faculty of Nursing. * In most cases, screen clips do not show the full screen as it would appear.

Setting up Citrix to use Adobe Acrobat DC

Your first order of business is to determine if Citrix Receiver is already installed on your computer. This will help you determine whether you need to contact IT (nursing.helpdesk@ualberta.ca) to install it on your computer.

If Citrix Receiver is installed, you should see it in the lower right corner of your taskbar. Often it will be hiding, so you may have to click the white arrow to reveal it. Have a look at the screenshot I’ve taken below to see if you have it.

At this point, if you have it, you can continue on with the process. If you do not, please contact the IT group and ask them to install “Citrix Receiver” on your computer.
Launching Adobe Acrobat DC via Citrix

So, you've determined you have Citrix Receiver, how do you go about using it? Go ahead and double-click the icon that's in your taskbar. This will launch it for you and you should see a screen similar to what I have below:

Login using your NURS User Name and Password (the same one you used to login to your computer).

The screen below will open:

Go ahead and click on “Apps”, which will let you add an application.
The screen that comes up will have numerous applications available. In this particular instance, we’re looking for Adobe Acrobat DC. Click on “Adobe Acrobat DC”.

![](image)

It may take a little patience while Adobe Acrobat DC is prepared. If you get a message that Adobe Acrobat DC is not available, it is likely that the maximum number of users has been reached. You will need to try again later.

*Now that you’ve launched the application, it’s a good time to remind you that only files in your documents folder will be accessible via the “Citified” version of Adobe Acrobat DC. This is because the application is actually running on a server elsewhere in the building, so only your documents folder carries over, similar to what would happen if you logged on to another computer.*

**A Couple of Final Tips**

1. There are a number of other Citrix applications available to you, simply return to Citrix Receiver again and click an icon to add other applications.
2. Be sure to close down the Adobe Acrobat DC application when you have finished using it. There is a limited number of users that can access these applications at any given time, and while that limit is generally fairly high, if you leave the application open, you’ll perpetually be using a space. To help ensure the applications are available for other users when needed, be sure to close yours down after you have finished.
Using Adobe Acrobat DC to Create One Document

When Adobe Acrobat DC opens, the screen should look like the picture below. (This is what a first-time user will see. If you have been using the application previously there may be files already on this page.) Go ahead and click on the “Tools” tab.

You will now see a screen giving you many options. You want to create a single file from numerous separate ones. Click on the “Combine Files” option.

You are now able to add the files you wish to combine into a single document. Click on “Add Files” then choose your desired files from your folders. Don’t worry about the order in which you add them. Order can be changed after files are all added.
After adding the files, the screen will show your documents.

![Image of Combine Files interface]

By highlighting a document it can be dragged on the screen, allowing you to reposition the items until they are arranged the way you’d like them in your final PDF. You can see that the documents in the screen above are rearranged in the screen below:

![Image of rearranged Combine Files interface]

Once the pages are arranged to your satisfaction, you will click on the “Combine” button on the right side of the screen. This will compile your separate documents into a single file.

![Image of Combine button being clicked]

Your document will come up in full page view. Simply use the sizing menu near the top of the screen to shrink the pages and see a fuller view of your document. At this point you’ll also see tools at the right of the screen that allow you to edit selected text and manipulate objects.
You’ll notice that the second page is in a different orientation than the others. You can leave it as it to print or opt to change it. To rotate the page, click on the “Tools” tab then select “Organize Pages”. Mousing over item 2 will bring up tools enabling the page to be rotated. When you have completed this operation, click again on “Organize Pages”. Make sure that you select “Back to Document” or your work may be lost. When you are returned to the document screen you’ll see that your page has been rotated to a more desirable orientation.

Once you are happy with your document you can save it, using the save option in the “File” menu at the top left of the screen.